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Objectives 5 palaall ilsa/

To provide students with a comprehensive understanding of word
processing concepts, features, and functionalities, enabling them to

create and format professional documents.
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Introduction to Word Processing

Word processing iIs the use of computer software to create, edit, format, and
print text-based documents. It is one of the most common and essential
computer skills. The most popular word processor is Microsoft \WWord, but

others include Google Docs, Apple Pages, and LibreOffice Writer.
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Introduction to Word Processing

1 Word Processing Basics

A word processor Is a significant upgrade from a typewriter. Its core advantages

are:

« Editability: You can change text anywhere in the document without re-typing
the whole page.

* Formatting: Control the appearance of your text (fonts, colors, sizes) and
layout (margins, spacing).

« Copy & Paste: Easily duplicate or move text and images.

«  Spell & Grammar Check: Automated tools to catch errors.

« Save & Store: Documents are saved digitally for easy retrieval and future
editing.

« Templates: Pre-designed documents for quick creation of resumes, letters,
reports, etc.
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New

1 When you open Word for the first time,

Search for online templates 2

Suggested searches:  Business  Personal  Industry  Print
Design Sets  Education  Event

: S

the Start Screen will appear. From here, you'll

be able to create a new document, choose

a template, and access your recently edited Take a
tour
documents. Account . —
Aa Title S
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Page 1 of 1

The Quick Access Toolbar
lets you access common
commands no matter which
tab is selected. By default, it
includes the Save, Undo, and
Redo commands.

AaBbCcDc AaBbCcDe AaBb(Cq
No Spacing Heading 1

CRNCIRCNE TRCTRRTES §

@:

Insert  Design Layout

rhesibbon |

The Ribbon contains all of
the commands you will need
to perform common tasks in
Word. It has multiple tabs,
each with several groups of
commands.

AL-Zahraa College of Medicine —University of Basrah

Document] - Word

AaBbCcDc| AaBbCeDe AaBbC¢




@ ¥ Document1 - Word &= - | X

Insert  Design Layout References Mailings Review  View Olenna M... g Share
& % | Calibri (Body) oL ELiELE. E5E 8 5
: B BIU-xxx|d PB===|%=- AaBbCcDc AaBbCcDc AaBbCc -
aste 2 = e i - - nming
: * A-Y- A-Aa- A A 2 itie |8l o fiNormal | No Spacing Heading 1 :
Clipboard 1~ ° Font e Paragraph e Styles P ~
L--|'..g.......1.......2.......3.,.....4...,...5.......6...‘5...7... £
: Document Pane
: This is where you'll type and
3 edit text in the document. -
[l P — il

AL-Zahraa College of Medicine —University of Basrah 6



The Word interface

Document1 - Word = - | % @ ¥ Document1 - Word @
Design Layout  References  Mailings Review  View Olenna M... g_ Share Insert  Design Layout References  Mailings Review  View Olenna M... P+ Share
=, % ||Calibri (Body) I R e e = = D &y 3 Calibri (Body) |11 cf| =iz eliz. | E3E || ' e
N B BIU-x.x|% B===|1=. AaBbCcDc| AaBbCeDc AaBbCc | ° B B I U-sex, x| % Bl===1=- AaBbCcDc| AaBbCcDe AaBhCi -
Pafte ¢ B> a-n| x| ne S Newnel | MoSpacing  Hesling1 [ Edltmg Pa'ste $ A-W. o B O | 8| o T Normal | No Spacing Heading 1 Ed:t.mQ
Jlipboard ra n Font I Paragraph ] Styles Ms ~ Clipboard & n Font fu Paragraph M Styles e -~
A TR TN ER RS ER RN RRRE FRRRERRE ERR R SECE RS SERTTREE SRER RS EEREERER PRRNEERE SRRRRRRT SRRy, e
: C : .
| o [ .
o Click and drag the vertical g
scroll bar to move up and < The Ruler is located at the
. down through the pages of : top and to the left of your
. your document. . document. It makes it easier
- - 5 to make alignment and
. ﬁ spacing adjustments. -
(] DT
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The Word interface

v V| BTEERTMY| A A |[JETIY] 2 E = v . ® R TZ-A A AA 2= 0V T
Clipboard % n Font 1 Paragraph M Styles i 4: Clipboard o Font & _ = P A
LM L2 '3 Cae R A s = — e e (-
) g o 8 o S fg | 1 2 RERRTREY.
_ - (+] There are three ways to view
’- adocument:

. i Read Mode displays your

; i document in full-screen »
: [+ mode. (+]

Print Layout is selected by

X 7 default. It shows the

; : document as it would appear

; Page and Word p on the printed page.

] Count i

. ; Web Layout shows how your

" From here, you can quickly i document would look as a

: see the number of words and - : webpage. Mo
[] s Pagesinyour document. D Z] [ 0
Pgeclion't °| B °==='o b——&8 & 90%  Pagetofi °..words (2 B .':' ~ — 05 = |
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The Word interface

- O R Z-A R TAXK | 3~H~ |2} 2 === I
Clipboard 1 n Font r; Paragraph = Styles e ~
L'i"‘l‘f-"‘-"iifg---:--'1-'--'--z--~|-~-3~--.--~4-~-n.-.5.......s...&u“._;a1*._;‘.‘ B
. -

N [+

. -
: Zoom Control

' Click and drag the slider to

) use the zoom control. The

: number to the right of the

" slider bar reflects the zoom

; percentage. =
L G I O
Page1of 1 ™ words [|2 B TE s - I*—’ 90%
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A The Ribbon H ©- ¢ -

< Document] - Word

File Insert Design Layout References Mailings Review View

* Word uses a tabbed Ribbon system instead of traditional

¥ | Calibri (Body) 11 v =iz e lioe €232
. . . . By | B I U ~abe x, x° | Ao =_ == =, AaBbCcDe AaBbCcDe
menus. The Ribbon contains multiple tabs, whichyou can = pste =\ "~ PSR Y T T Normal | No Spacing
find near the top of the Word window. SEREESEE — - rararEen . s

* Tabs: Home, Insert, Draw, Design, Layout, References,
Mailings, Review and View.

Document] - Word

« Each tab contains several groups of related commands.

Insert Design Layout References Mailings Review View
i B ¥ | Calibri (Body) 11 r|i= iz tine =3
For example, the Font group on the Home tab contains [y & |tn Bod , =N e naBbecnd AsBbCCDe
P I: B I Q - abe X, X '%' = — — — =
. . aste P i
commands for formatting text in your document. . ¥|A-¥-A-ma- KN |D-E AT Z~ormz ] NoSpacing
Clipboard = Font a Paragraph a Styles
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* Some groups also have a small arrow in
the bottom-right corner that you can click
for even more options.

v Dacument] - Waord

Insert Design Layout References Mailings Review View

B ¥ || Calibri (Body) 1 v =iz ise EE3S
By | B I U -abx, x* | % = === 1= AaBbCcDc AaBbCcDe
Pafte ¥ M. A-ha- A A CE e AL TMormal | Mo Spacing
Clipboard = Font P Paragraph P Styles
L 1"""'5"""'1"'D%ﬂntl[[trhﬂl

—

= Customize your text using advanced

|~ - font and character options to give it

= — the exact look you want.

= You can add a vaniety of styles and

s | COlOrs to your text, as well as visual

- cooe=l|  effects, like strikethrough,
superscript, and all caps.
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d Showing and hiding the Ribbon
If you find that the Ribbon takes up too much screen space, you can hide it.
To do this, click the Ribbon Display Options arrow in the upper-right

corner of the Ribbon, then select the desired option from the drop-down

menu:
------ Auto-hide Ribbon

Hide the Ribbon. Click at the top
of the application to show It.

e Auto-hide Ribbon: Auto-hide displays your document in full-
screen mode and completely hides the Ribbon from view. To

AaBbCcl

show the Ribbon, click the Expand Ribbon command at the No Spaci ’E Show Tabs

top of screen. Show Ribbon tabs only. Click a
 Show Tabs: This option hides all command groups when Styles tab to show the commands.

they're not in use, but tabs will remain visible. To show the - 5 _ | Show Tabs and Commands

Ribbon, simply click a tab. = | Show Ribbon tabs and

. . .. commands all the time.
e Show Tabs and Commands: This option maximizes the

Ribbon. All of the tabs and commands will be visible. This
option is selected by default when you open Word for the
first time.
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Working with the Word environment

1 The Quick Access Toolbar

Located just above the Ribbon, the Quick Access Toolbar lets you access common commands
no matter which tab is selected. By default, it shows the Save, Undo, and Redo commands, but

you can add other commands depending on your needs

To add commands to the Quick Access Toolbar:

o Click the drop-down arrow to the right of the Quick Access Toolbar.

H ©-

h

File Home Insert Design

s X -
D Calibri (Body) ~|11 ~ A

Paste . B I U ~abex, x

Clipboard Font
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Customize Quick Access Toolbar Insert Design

By Y o New B & 4 a
D . Calibri (Boc - EY} D e Calibri (Body) ~ |11 ~ A
Pa'ste gl .. £= Paste ¢ B I U ~-abex X
Clipboard Email Clipboard Font
. Quick Print ol
- Print Preview and Print

Spelling & Grammar
| v Undo
v Redo
Draw Table
Touch/Mouse Mode
More Commands..,

i Show Below the Ribbon

I ——
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(J The Ruler

The Ruler is located at the top and to the left of your document. It makes it easier to adjust your document with
precision. If you want, you can hide the Ruler to create more screen space.

To show or hide the Ruler:

G Click the View tab.

e -

Document] - Word
Insert Design

Layout References Mailings Review View

& I calibri (Body) ~|11 ~| A" A" | Aa~

S T s S = = A
P i=-i=- |=3= | 2l | T (Jassbcedd] Aal
Pa_ste ¢ B I U-acx. x| A-F-A-B===|1=-S-H- T Normal | No
Clipboard = Font M Paragraph =
° Click the checkbox next to Ruler to show or hide the Ruler.
H - [ v

Documentl - Word
File Home Insert Design

Layout References Mailings

Review View <
N [=] Outline Ruler _) E] One Page r\j
E'] D F@ [=] Draft %Gridlines q [;I EE Multiple Pages - E D
Read  Print Web o = Zoom 100% New Arrange Split
Mode Layout Layout Navigation Pane I Page Width Window All
Views Show Zoom
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] Backstage view

Backstage view gives you various options for saving, opening a file, printing, and sharing your document. To
access Backstage view, click the File tab on the Ribbon.

Document? - Word B = ] %

Olenna Mason

[ Info

| rt D . Protect Document Properties -
nse =7 g n } Control what types of changes people Size Not saved yet
Protect can make to this document. P 1
Document ~ ages
":|:'I Words 0
- - 4k .o . .
':Hllhrl I:Eljd}l-:l - 'I 'I - .A Total Editing Time 18 Minutes
Title Add a title
= Inspect Document
= @ o o Tags Add atag
Befaore publishing this file, be aware .
P ESI:E B I u - I I = Check for eh i e Comments Add comments
'f —_ ah 3 z Issues - Document properties and
- author's name Related Dates
Last Madified
Clipboard s Font —~ Manage Document Created Today, 10:50 AM
C)\ Check in, check out, and recover Last Printed
Manage unsaved changes.
Account Document ¥ There are no unsaved changes. Related People
Author
Options Olenna...

Add an author
Last Modified By Mot saved yet

Show All Properties
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You can use the arrow to
close Backstage view and
return to Word.

®Save As
rint @
@ Check for
@Share Issues ~
@
@Iose '—LW
Q

Manage
Document ~
@A(count
G)ptrons

Document? - Word

Protect Document

Control what types of changes people
can make to this document.

Inspect Document

Before publishing this file, be aware
that it contains:

% Document properties and
author's name

Manage Document

Check in, check out, and recover
unsaved changes.

7] There are no unsaved changes.

-

Properties ~
Size

Pages

Words

Total Editing Time
Title

Tags

Comments

Related Dates
Last Modified
Created

Last Printed

Related People
Author

Last Modified By

- |

Olenna Mason

Not saved yet
1

0

18 Minutes
Add a title
Add atag

Add comments

Today, 10:50 AM

H Olenna...

Add an author

Not saved vet
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The information pane will

appear whenever you access
Backstage view. It contains
information on the current
document. You can also
inspect the document to
remove personal info and
protect it to keep others from
making further changes.

Q
Manage
Document ~

[Bﬁ(count

@Optrons

Document? - Word

Protect Document

Control what types of changes people
can make to this document.

Inspect Document

Before publishing this file, be aware
that it contains:

% Document properties and
author's name

Manage Document

Check in, check out, and recover
unsaved changes.

7] There are no unsaved changes.

Properties ~
Size

Pages

Words

Total Editing Time
Title

Tags

Comments

Related Dates
Last Modified
Created

Last Printed

Related People
Author

Last Modified By

- ()

%

Olenna Mason

Not saved yet
1

0

18 Minutes
Add a title
Add atag

Add comments

Today, 10:50 AM

M Olenna...

Add an author

Not saved yet
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From here, you can create a
new blank document, or you
can choose from a large
selection of templates.

@Zlose a

Manage
Document ~

@&ccount
@)phons

Document1 - Word

Protect Document

Control what types of changes people

can make to this document.

Inspect Document

Before publishing this file, be aware
that it contains:

% Document properties and
author's name

Manage Document

Check in, check out, and recover
unsaved changes.

7 There are no unsaved changes.

-

Properties ~
Size

Pages

Words

Total Editing Time
Title

Tags

Comments

Related Dates
Last Modified
Created

Last Printed

Related People
Author

Last Modified By

- ]

Olenna Mason

Not saved yet
1

0

18 Minutes
Add a title
Add atag

Add comments

Today, 10:50 AM

n Olenna...

Add an author
Not saved yet

From here, you can open
documents saved to your
computer or to your
OneDrive.

@aose a

Manage
Document ~

E}&ccount
ptlons

Document? - Word

Protect Document

Control what types of changes people
can make to this document.

Inspect Document

Before publishing this file, be aware
that it contains:

% Document properties and
author's name

Manage Document

Check in, check out, and recover
unsaved changes.

7] There are no unsaved changes.

-

Properties ~
Size

Pages

Words

Total Editing Time
Title

Tags

Comments

Related Dates
Last Modified
Created

Last Printed

Related People
Author

Last Modified By

- ] %

Olenna Mason

Not saved yet
1

0

18 Minutes
Add a title
Add atag

Add comments

Today, 10:50 AM

pl Olenna...

Add an author

Not saved yet
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Info

Protect
Document ~

Save and Save As

You'll use Save and Save As
to save documents to your
computer or to OneDrive.
Manage
Document ~

@Account

@)ptlons

Document! - Word

Protect Document

Control what types of changes people
can make to this document.

Inspect Document

| Before publishing this file, be aware

that it contains:

% Document properties and
author's name

- Manage Document

Check in, check out, and recover
unsaved changes,

] There are no unsaved changes.

-~

Properties ~
Size

Pages

Words

Total Editing Time
Title

Tags

Comments

Related Dates
Last Modified
Created

Last Printed

Related People
Author

Last Modified By

C
Not saved y /.
] Protect
Document ~
0

18 Minutes

Add a title
Add a tag (¥ ) .
Add comme

From the Print pane, you can
Today, 10:3( change the print settings

and print your document.
You can also see a preview of
your document.

o

Add an autt

Not saved y

Document! - Word

Protect Document

Control what types of changes people
can make to this document.

Inspect Document
Before publishing this file, be aware

that it contains:

¥ Document properties and
author's name

Manage Document

Check in, check out, and recover
unsaved changes.

™1 There are no unsaved changes.

-

Properties ~
Size

Pages

Words

Total Editing Time
Title

Tags
Comments

Related Dates
Last Modified
Created

Last Printed

Related People
Author

Last Modified By

- (m| %

Olenna Mason

Not saved yet
1

0

18 Minutes
Add a title
Add atag

Add comments

Today, 10:50 AM

ﬁ Olenna...

Add an author

Not saved yet

AL-Zahraa College of Medicine —University of Basrah

20



Info

Prot
Document ~

Check for
Issues ~

From here, you can invite

people to view and
collaborate on your
document.

Document1 - Word

Protect Document

Control what types of changes people
can make to this document.

Inspect Document

Before publishing this file, be aware
that it contains:

¥ Document properties and
author's name

Manage Document

Check in, check out, and recover
unsaved changes.

j There are no unsaved changes,

w

Properties ~
Size

Pages

Words

Total Editing Time
Title

Tags

Comments

Related Dates
Last Modified
Created

Last Printed

Related People
Author

Last Modified By

- ] P4

Olenna Mason

Not saved yet
1

0

18 Minutes
Add a title
Add a tag

Add comments

Today, 10:50 AM

M Olenna...

Add an author

Not saved yet

Info

»
Protect
Document ~

Check for
Issues ~

From here, you can export
your document in another

t file format, such as PDF/XPS.

Document1 - Word

Protect Document

Control what types of changes people

can make to this document,

Inspect Document

Before publishing this file, be aware
that it contains:

®  Document properties and
author's name

Manage Document

Check in, check out, and recover
unsaved changes,

] There are no unsaved changes.

Properties ~
Size

Pages

Words

Total Editing Time
Title

Tags

Comments

Related Dates
Last Modified
Created

Last Printed

Related People
Author

Last Modified By

- m} %

Olenna Mason

Not saved yet
1

0

18 Minutes
Add a title
Add a tag

Add comments

Today, 10:50 AM

Fj Olenna...

Add an author

Not saved vet
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Protect
Document ~

Check for
Issues ~

Click here to close the
§ currentdocument.

Document? - Word

Protect Document

Control what types of changes people
can make to this document.

Inspect Document

Before publishing this file, be aware
that it contains:

¥ Document properties and
author's name

| Manage Document

Check in, check out, and recover
unsaved changes.

_j There are no unsaved changes.

w

Properties ~
Size

Pages

Words

Total Editing Time
Title

Tags

Comments

Related Dates
Last Modified
Created

Last Printed

Related People
Author

Last Modified By

- m|

Olenna Masa

Not saved yet
1

0

18 Minutes
Add a title
Add a tag

Add comments

Today, 10:50 AM

H Olenna...

Add an author

Not saved vet

Info

»

Protect
Document ~

fl.x
v
v

Check for
Issues ~

Q
Manage
Document ~

From the Account pane, you
can access your Microsoft
account information, modify
your theme and background,
and sign out of your account.

Protect Document

Control what types of changes people
can make to this document.

Inspect Document

Before publishing this file, be aware
that it contains:

% Document properties and
author's name

Manage Document

Check in, check out, and recover
unsaved changes.

7] There are no unsaved changes.

Properties ~
Size

Pages

Words

Total Editing Time
Title

Tags

Comments

Related Dates
Last Modified
Created

Last Printed

Related People
Author

Last Modified By

Show All Properties

Not saved yet
1

0

18 Minutes
Add a title
Add a tag

Add comments

Today, 10:50 AM

p‘ Olenna...

Add an author

Not saved yet
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g)pe” Prot

S Document ~
@Save As
[ET“M @
Check for

@Share Issues ~

e -
@Iose ?.Ll

Manage
Document ~

@Qccount

Here, you can change various
Word options. For example,
you can control the spelling
and grammar check settings,
AutoRecover settings, and
language preferences.

Protect Document

Control what types of changes people
can make to this document,

Inspect Document

Before publishing this file, be aware
that it contains:

% Document properties and
author's name

Manage Document

Check in, check out, and recover
unsaved changes.

"] There are no unsaved changes.
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Properties -
Size

Pages

Words

Total Editing Time
Title

Tags

Comments

Related Dates
Last Modified
Created

Last Printed

Related People

Author

Last Modified By

Show All Properties

Working with the Word environment

Not saved yet
1

0

18 Minutes
Add a title
Add a tag

Add comments

Today, 10:50 AM

Fq Olenna...

Add an author
Not saved yet
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Working with the Word environment
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J Document views and zooming

Word has a variety of viewing options that change how your
document is displayed. You can choose to view your
document in Read Mode, Print Layout, or Web Layout.
These views can be useful for various tasks, especially if
you're planning to print the document. You can also zoom in
and out to make your document easier to read.

Tools View Academic Paper - Word

without whom the SR would not have been able to solicit and select the excellent writers that

= Switching document views

SWitChing between diffe rent dOCU ment VieWS is easy. Just SR has housed only five, with the most recent editor, George Core, beginning his run in 1973,
locate and Select the desired docu ment view Command in Andrew Nelson Lytle. one of the South’s more distinguished (and underappreciated) men of let- B
the bottom—right Corner Of the Word WindOW' ters, edited the Sewarnee Review twice in his career, once in 1942 to 44 and then again from 1961 k’)

have graced their pages during these past decades. For the last seventy-six years, the office of the

/_-\- N
| &)
N

to 1973. During his tenure as editor, Lytle helped to resurrect the magazine from academic stag-

nation, financial straits and a dwindling readership while presenting some of the twentieth cen-

* Read Mode: This view opens the document to a full screen. fury’s finest critcs, writers and poets.
This view is great for reading large amounts of text or simply
reviewing your work.

l:l Read Mode|
Screen 2 of 77 E B -—+ 100%
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* Print Layout: This is the default document
view in Word. It shows what the document
will look like on the printed page.

Web Layout: This view displays the document
as a webpage, which can be helpful if you're
using Word to publish content online.

] E

Insert Design

Review i ne.. Olenna M.
S Times -2 - o
g L e e ABCC AaBbCcl AaBbCel | °
Pote e R-W A -mae| KA DaeiE e THeading 1 TNormal TN Spac... |<| Editing
Clipboard 1 Font = Paragraph = Styles =
I-1‘-‘\‘--e-‘-?-‘-1-"I--‘1‘-‘\‘--J“-\-‘-4-“I--‘5‘-‘I‘--S“-é-‘-?-‘-

bl ?

the time. Indeed, a great deal of the magazine’s continued excellence has depended on its editors,
without whom the SR would not have been able to solicit and select the excellent writers that
have graced their pages during these past decades. For the last seventy-six years, the office of the
. SR has housed only five, with the most recent editor, George Core, beginning his run in 1973

: Andrew Nelson Lytle, one of the South’s more distinguizhed (and underappreciated) men of
letters, edited the Sewanee Review twice in his career, once in 1942 to 44 and then again from

1961 to 1973. During his tenure as editor, Lytle helped to resurrect the magazine from academic

. stagnation, financial straits and a dwindling readership while presenting some of the twentieth
EIN

Print Layout | [v]
Page 1 of 29 [ Eﬁ B -— b+ 9%

w2 = Academic Paper - Word - a x
Insert Design Layout  References  Mailings  Review Olenna M... Fi Share
Sy 3 Times -2 - o)
By BT U -aex, x| 20 B AaBbCcl AaBbCel AaBbCel o
Paste oo ' ~ Editing
" & A-W. A-Aa- | A A Q . THeading1 TMormal THNoSpac.. = .
Clipboard & Font [F] Paragraph [F} Styles LM ~
. EE e SRR SR AR SR BRSPS R SRR SRS AR ST BRI - 7oA
%‘ewaneeRevi

ew. Founded in 1892, the Sewanee Review (SR) has never missed an issue, distmguish?]é it ;5
the oldest continuously published quarterly review in the United States. For its first half-century, the
magazine existed as a general journal of the Humanities, featuring articles on literature, art, politics, and the
South. In the early 1940s its focus became purely literary, and the SR now regularly publishes superb essays,
literary criticism, fiction, poetry and, of course, reviews of current books. This shift in tone was facilitated
expressly by the editors of the time. Indeed, a great deal of the magazine’s continued excellence has
depended on its editors, without whom the SR would not have been able to solicit and select the excellent

writers that have praced their pages during these past decades. For the last seventy-six sw==r= +ha office of the
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Working with the Word environment

)
Y 0.
("\il) of P,

1 Zooming in and out

To zoom in or out, click and drag the zoom control slider in
the bottom-right corner of the Word window. You can also
select the + or - commands to zoom in or out by smaller
increments. The number next to the slider displays the

current zoom percentage, also called the zoom level.

rs of the time. Indeed. a great deal of the magazine’s
ed on its editors, without whom the SR would not have

+ excellent writers that have graced their pages during  Zoomin|
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Document Lifecycle: Creating, Editing, Opening, Saving, and
Closin

 Creating a New Blank Document:

« Click the "File" tab and select "New*
« Choose "Blank Document" or select a template based on your needs

d Opening an Existing Document:

* Click the "File" tab and select "Open*
« Browse to the location of the document you want to open
* Double-click on the document file to open it
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Document Lifecycle: Creating, Editing, Opening, Saving, and
Closin

1 Saving Your Work: The most critical habit.
First Save: Ctrl+S or File > Save As. Choosing a location, naming the file, and selecting a
format (.docx, .pdf, etc).

 Saving Changes to an Existing Document

« Use "Save" to update changes to an already saved file.

« Use "Save As" to create a new version or save changes under a different name/location
1 Closing a Document: A Word document can be closed in several ways:

by clicking the X in the upper-right corner, using the keyboard shortcut Ctrl + W, or
selecting File > Close from the menu.”
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Creation, Manipulation, and Professional Formatting

 Text Creation: Basic text entry, using the Enter key for new paragraphs
and Shift+Enter for a line break.
d The Art of Selection:
* Click and drag.
« Double-click to select a word.
« Triple-click to select a paragraph.
« Ctrl+Ato Select All.
d Core Editing Commands :
« Copy (Ctrl+C): Duplicates the selected text.
« Cut (Ctrl+X): Removes the selected text to be placed elsewhere.
« Paste (Ctrl+V): Inserts the copied/cut text.
« Paste Special: Options for pasting without formatting.
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Creation, Manipulation, and Professional Formatting

1 Power Tools for Efficiency:

* Find (Ctrl+F): Locates specific text.

* Find and Replace (Ctrl+H): Allows you to search for a specific word or

phrase in the document and replace it with another.

Example: Replacing “Zmcollege” with “ZMC” throughout the entire
document.

* Undo & Redo (Ctrl+Z, Ctrl+Y): Your digital safety net.
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d Formatting: From Plain Text to Polished Document

A. Character/Text Formatting (Affects selected text):

Font Face: Refers to the style or design of the text. Examples include Times New
Roman, Calibri, Arial, and many others.

Font Size: Indicates how large or small the text appears, and it is measured In
points (pt).

Styles: Used to add emphasis or change the appearance of text. Common styles
Include Bold, Italic, and <u>Underline</u>.

Highlighting and Font Color: Used to emphasize important words or sections in
a document by changing the text color or adding a background highlight.
Advanced Effects: Include additional formatting options such as Subscript,
Superscript, and various Text Effects (like shadow, glow, and outline) to enhance
the appearance of text.
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Creation, Manipulation, and Professional Formatting

B. Paragraph Formatting (Affects entire paragraphs):
« Alignment: Controls how text is positioned horizontally on the page. The main

alignment options are Left, Center, Right, and Justified.

* Line Spacing: Determines the amount of vertical space between lines of text. Common
options include Single, 1.5, and Double spacing. Proper line spacing is essential for
readability and meeting academic formatting requirements. =
* Indentation: Changes the space between text and the margin
 First Line Indent: Only the first line moves inward.
« Hanging Indent: All lines except the first move inward.

» Bulleted and Numbered Lists: Used to organize information clearly.
* Bulleted List: For unordered items. L

« Numbered List: For items in a specific order.  *— ~

i
i
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End of Session Questions

1. Which of the following is NOT a popular word processor?
a) Google Docs
b) Microsoft Excel
c) Apple Pages
d) LibreOffice Writer
2. Which tab in the Ribbon contains the “Font” group?
a) Insert
b) Design
c) Home
d) Review
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End of Session Questions

Short Answer / Explanation Questions
1. Explain the difference between “Save” and “Save As.”

2. What are the three default commands in the Quick Access Toolbar?

Scenario-Based / Application Questions

1. You’re writing a research paper and want to ensure all section headings look
consistent. Which Word feature would you use, and why?

2. If you accidentally delete a paragraph, what is the quickest way to restore it?
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